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1 Preface
Mari is a creative texture-painting tool that can handle extremely complex or texture heavy projects. It was
developed at Weta Digital and has been used on films such as The Adventures of Tintin: The Secret of the Unicorn,
District 9, TheDay the Earth Stood Still, The Lovely Bones and Avatar.

The nameMari comes from the Swahili 'Maridadi', meaning 'beautiful' and carrying connotations of 'usefulness'.

About This Guide
This guide provides you with the basic information you need to start painting with Mari.

The first part of themanual, Installation and Licensing, describes how to install, license, and launchMari.

The rest of themanual consists of a few short chapters describingMari’s basic functionality and five tutorials, which
teach you the basics of creating aMari project and painting textures. The tutorials provide a series of comprehensive
walk-throughs, completewith geometries and associated textures. As you follow the steps in these tutorials, you'll
gain a good feel forMari's user interface and workflow. This, in turn, provides a good working knowledge for creating
more complex production projects.

Formore detailed information onMari and its functions, see the accompanyingMari User Guide andMari Reference
Guide.

Contact Customer Support
Should questions arise that thismanual fails to address, you can contact Customer Support directly via e-mail at
support@thefoundry.co.uk or via telephone to our London office on +44 (0)20 7479 4350 or to our Los Angeles
office on (310) 399-4555 during office hours.
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2 Installation and Licensing
Tomake the instructions easier to navigate, specific instructions for how to install, launch, and licenseMari are
grouped together by operating system so you can quickly find everything in one place.

The operating systems supported by Mari are:

• Windows,

• Linux, and

• Mac OS X.

System Requirements
Each operating systemhas its own system requirements forMari, and this includes approved graphics card
requirements. To check the individual system requirements for each operating system, see:

• Windows SystemRequirements

• Linux SystemRequirements

• Mac SystemRequirements

Due to the number of cards available in themarket, we are unable to test every card and, therefore, cannot officially
qualify all of them individually. However, if yourmachine/GPU specificationsmeet the requirementsmentioned,
theoretically Mari should work fine for you. If you encounter any issues, please contact support@thefoundry.co.uk.

Below is a list of approved graphics cards that have been tested for usewith Mari.

Mac OS X Tested Graphics Cards
• NVIDIA GeForce GT 650M

• NVIDIAQuadro (Fermi Series) 4000

Windows and Linux Tested Graphics Cards
• NVIDIA GeForce GTX 480

• NVIDIA GeForce GTX 580

• NVIDIA GeForce GTX 680

• NVIDIAQuadro (Fermi Series) 4000
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• NVIDIAQuadro (Fermi Series) 5000

• NVIDIAQuadro (Fermi Series) 6000

• NVIDIAQuadro K2000

• NVIDIAQuadro K4000

• NVIDIAQuadro K5000

• AMD FirePro W7000

• AMD FirePro W8000

• AMD FirePro W9000

• AMD Radeon HD 7850

• AMD Radeon HD 7950

Please download and install the latest graphics driver for your card from theNVIDIA or AMD websites.

NOTE: Ensure that you are using 8.982.8.1 (AMD Catalyst 12.10) drivers or higher for AMD cards.

Virtual Memory Requirements

It is recommended that the system runningMari has plenty of virtual memory available to use, especially when
handling large projects. The use of virtual memory improves stability, helping to prevent data loss on large projects.

Windows

Windows SystemRequirements
• Windows 7 64-bit andWindows 8.1 64-bit.

• Quad-core x86-based processor.

• 250GB disk space available for caching and temporary files (or aminimumof 50GB if you're working on a small
project).

• At least 4GB RAM.

• Display with 1680 x 1050 pixel resolution.

• An NVIDIA or AMD graphics card with at least 1GB of RAM and OpenGL 3.2 support (seeWindows and Linux
Tested Graphics Cards).

NOTE: Displacement preview is currently only available on the cards and drivers that support OpenGL 4.0
or newer.
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Installation on Windows

Mari 2.6 is available to download fromourweb site at www.thefoundry.co.uk/products/mari. The download is in a
compressed .exe format.

1. Download the .exe installation file fromourweb site.

2. Double-click on the installation file to start the installation. Follow the on-screen instructions. By default, Mari is
installed to [drive letter]:\Program Files\Mari [version number].

3. That's it! Proceed with Launching onWindows.

Installing Mari from the Command Line
1. Download the correct .exe installation file fromourweb site at www.thefoundry.co.uk/products/mari.

2. To open a command prompt window, select Start > All Programs > Accessories > Command prompt.

3. Use the cd (change directory) command tomove to the directory where you saved the installation file. For
example, if you saved the installation file in C:\Temp, use the following command and press Return:
cd \Temp

4. To install Mari, do one of the following:

• To install Mari and display the installation dialog, type the name of the install file without the file extension and
press Return:
Mari2.6v5-win-x86-release-64

• To install Mari to a specified directory and display the installation dialog, use the /dir install option:
Mari2.6v5-win-x86-release-64 /dir="E:\Mari"

• To install Mari silently so that the installer does not prompt you for anything but displays a progress bar, enter
/silent after the installation command:
Mari2.6v5-win-x86-release-64 /silent

• To install Mari silently so that nothing is displayed, enter /verysilent after the installation command:
Mari2.6v5-win-x86-release-64 /verysilent

• You can also use a combination of install options:
Mari2.6v5-win-x86-release-64 /silent /dir="E:\Mari"

NOTE: By running a silent install of Mari, you agree to the terms of the EULA. To see this agreement,
please refer to Appendix D: End User Licensing Agreement in theMari User Guide, or run the installer in
standard non-silent mode.

Launching on Windows
1. Click Start > All Programs > The Foundry > Mari 2.6v5 > Mari 2.6v5.
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2. If you haven’t installed a license forMari, you need to choose fromone of the options for Licensing onWindows.
Once you’ve done so, click Launch in theMari Licensing dialog.

3. Mari checks forWindows and Linux Tested Graphics Cards, and if an untested graphics card configuration is
detected, a dialog displays warning you about it. Depending on the configuration detected, you have the option
toQuit or Continue and, in the case of configurations with known issues, also Ignore Permanently.

NOTE: If you ignore thewarning and runMari anyway, youmay experience instability or performance
issues. If a tested graphics card configuration is detected, Mari runs as normal.

4. If you are launchingMari for the first time, you are prompted to select a directory for its cache files. In the
Please Pick Cache Directory dialog, navigate to the directory you want to use and click Choose.

TheMari graphical interface displays.

Please note that the cache directory should be:

• empty

• local to themachine (not a network mount)

• as fast as possible

• a location that's not temporary (to avoid the data disappearing)

• a directory that the user has read and write permissions to.

Project cache locations are directories that Mari uses to store project data files. These directoriesmust be persistent;
not in temporary locations. If more than one cache location is specified, Mari spreads each project’s data files across
all locations. Once a project has been created for a given set of cache locations, that set must not be changed. In
order to move a project between different sets of caches, archive the project.

NOTE: Do not add, remove, or amend cache locations once they have been set unless they are empty.
Once projects have been created for a given set of cache locations, that set must not be changed or project
corruption will occur.

NOTE: If theMARI_CACHE environment variable has been set, its value is used to determine the location
of the cache files. In this case, Mari does not prompt you to select the cache directory. Formore
information on environment variables that Mari understands, please refer to theMariUser Guide.

NOTE: You can also launchMari in verbosemode by selecting Start > All Programs >Mari 2.6v5 >Mari
2.6v5 (Verbose Output). This way, Mari provides a running log of each action that it performs. You can
see this log in a command linewindow.

Licensing on Windows

If you simply want to try out Mari, you can obtain a trial license, which allows you to runMari for free for 15 days.
See Install the License on page 14.
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To useMari after this trial period, you need either a valid activation key, node locked license, or a floating
license and server running the Foundry Licensing Tools (FLT):

• Activation Keys and Node Locked Licenses - these are used to license applications on a singlemachine. They
do not work on different machines and if you need them to, you’ll have to transfer your license.

Node locked licenses, sometimes called uncounted licenses, do not require additional licensing software to be
installed. See LicensingMari on a SingleMachine formore information.

• Floating Licenses - these are used to license applications on any networked client machine. The floating license is
put on the server and is locked to a unique number on that server.

Floating licenses, sometimes called counted licenses, require additional software to be installed on a server to
manage the licenses and give themout to the client stations that want them. This software is called the Foundry
Licensing Tools (FLT) and can be downloaded at no extra cost fromourwebsite. See LicensingMari over a Network
formore information.

The instructions below run through both licensingmethods. You can also find amore detailed description in the
Foundry Licensing Tools User Guide available on our website: http://www.thefoundry.co.uk/support/licensing/tools/

Licensing Mari on a Single Machine

Obtain an Activation Key

To obtain a license, you'll need yourmachine's System ID (sometimes called Host ID or rlmhostid). Just so you know
what a System ID number looks like, here’s an example: 000ea641d7a1.

NOTE: Bear inmind that, for floating licenses, you'll need the System ID of the license server, not the
machines on which you intend to runMari.

There are a number of ways you can find out yourmachine's System ID:

• LaunchMari without a license, click Status, and then scroll down the error report until you see your System ID.

• Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. Your
System ID is displayed.

• Download the Foundry Licensing Tools (FLT) free of charge fromwww.thefoundry.co.uk/support/licensing/ and
then run C:\Program Files\TheFoundry\LicensingTools7.0\ Foundry LicenseUtility.exe

When you know your System ID, you can request a license for The Foundry products:

• from The Foundry's Sales Department at sales@thefoundry.co.uk

• from the product pages on ourweb site, such as www.thefoundry.co.uk/products/mari/

• by launchingMari without a license and selecting:

• Buy Mari - opens aweb browser directly to The Foundry website to purchase a license.

• Try Mari - displays the 15-day trial license download screen. Enter your The Foundry account details or create
a new account and follow the on-screen instructions to receive a trial license.
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NOTE: By default, if you have installed a temporary license, Mari displays a dialog at start-up alerting you
to the number of days remaining. If you want to disable this behavior, you can set the FN_DISABLE_
LICENSE_DIALOG environment variable to 1 to suppress thewarningmessage about imminent license
expiration. See Environment Variables That Mari Recognizes in theMari User Guide formore information.

Install the License

You are prompted to enter your activation key when you start Mari without a license. Mari skips this step if you’ve
already activated the application.

When you start the application before installing a license, a Licensing dialog displays an error, informing you that no
licensewas available. The installation process is dependent on what type of license you requested:

• License file - if you requested a license file, typically foundry.lic, this option allows you to browse to the file
location and install it automatically. See To install a license fromdisk formore information.

• Activation Key or license text - if you requested an Activation Key or license by email, this option allows you to
paste the key or license text into the Licensing dialog, which then installs the license in the correct directory. See
To install an Activation Key or license text formore information.

• A floating license - if you requested a floating license to supply licenses to multiple client machines, this option
allows you enter the server address that supplies the client licenses.

NOTE: Youmust install a floating license and additional software on the license server to use this option.

See Install Floating Licenses formore information.

TIP: If you later want to check the current status of your license (for example, to see if it’s a node locked
license or a floating license), select Tools > License in Mari to display theMari Licensing dialog.

To install a license fromdisk
1. Save the license file to a known location on disk.

2. LaunchMari.

The Licensing dialog displays.

3. Click Install License to display the available license installation options.

4. Click Install from Disk.

5. Browse to the location of the license file.

6. ClickOpen to install the license automatically in the correct directory.

To install an Activation Key or license text
1. LaunchMari.
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The Licensing dialog displays.

2. Click Install License to display the available license installation options.

3. Click Activation Key / License Text and then either:

• Enter theActivation Key string in place of Insert Activation Key Here. A license key typically looks
something like this:
mari-0101-77d3-99bd-a977-93e9-8035

OR

• Copy the license text and paste it over theCopy/Paste license text here string. License text typically looks
something like this:
LICENSE foundry mari_i 2015.1223 permanent 2 share=h min_timeout=30

start=23-jan-2015 issuer=sf issued=23-jan-2015 replace

_ck=6dd78e4c69 sig="60PG452MPDMMM6MJAMRGKNQAN3PEAK8JYTHN45022M0C98H

XFA9N7SAASMRABT8TUJ6FAMX8TWU0"

4. Click Install.

The license is automatically installed on yourmachine in the correct directory.

NOTE: Activation Keys require an internet connection. If you access the internet through a proxy server
and cannot connect to the activation server, youmay get an error dialog prompting you to either:

-Click Use Proxy to enter the proxy server name, port number, username, and password. This enables the
application to connect to the activation server and obtain a license. The license is then installed
automatically, or
-Click on theweb link in the dialog and use the System ID (also known as hostid) provided to manually
activate and install a license.

Licensing Mari over a Network

Obtain Floating Licenses

Alternatively, you can purchase a floating license key fromourwebsite.

1. Display your system ID by doing one of the following:

• LaunchMari without a license, click Status, and then scroll down the error report until you see your System ID.

• Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. Your
System ID is displayed.

• Download the Foundry Licensing Tools (FLT) free of charge fromwww.thefoundry.co.uk/support/licensing/
and then run C:\Program Files\TheFoundry\LicensingTools7.0\ Foundry LicenseUtility.exe

2. Once you have provided us with your System ID number and a license key has been generated for you, you’ll
receive the license key in an e-mail or Internet download. The license key is contained in a text file called
foundry.lic. For information on what to do with the foundry.lic file, see Install Floating Licenses.
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Install Floating Licenses

If you requested a floating license from The Foundry, you will receive your license key (foundry.lic) in an email or
internet download. You should also receive the Foundry LicenseUtility (FLU) application to help you install the
license key on the license servermachine. The servermanages licenses for the clientmachines on your network.

NOTE: The FLU is also available to download fromwww.thefoundry.co.uk/support/licensing/

1. Make sure you have saved both the license key (foundry.lic) and the Foundry LicenseUtility application in the
same directory.

2. Run the FLU application.

The license key automatically appears in the FLU window if the FLU and foundry.lic are in the same directory.

TIP: If they are not in the same directory, you can either copy and paste the contents of the license key or
drag-and-drop the file into the FLU window.

3. Click Install.

This checks the license file and, provided that the license is valid, installs it into the correct directory.

4. In order for the floating license to work, you will need to install the Foundry Licensing Tools (FLT) on the license
servermachine.

Formore information on how to install floating licenses, refer to the FLT User Guide, which you can download
fromourwebsite www.thefoundry.co.uk/support/licensing/

5. Once your license server is up and running, launchMari on the client machine.

6. Click Use Server and enter the server address in the field provided. The format for the server name is:
<port>@<servername>, for example, 30001@red.

NOTE: Youmust perform steps 5 through 7 on each client machine that requires aMari license from the
server.

TIP: If you later need to display theMari Licensing dialog again, you can select Tools > License in Mari.

Further Reading
Formore information on licensingMari, displaying the System ID number, setting up a floating license server,
adding new license keys andmanaging license usage across a network, you should read the Foundry Licensing
Tools User Guide available on our website.
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Linux

Linux SystemRequirements
• Linux 64-bit operating system (Fedora 12 or Red Hat Enterprise Linux 5.4).

NOTE: Some newer Linux distributions have changed their network device configuration handling and
won’t work with Mari without some configuration changes. Known affected distributions at this time
include Fedora 16, Red Hat Enterprise Linux 6, and CentOS 6 on certain, notably Dell, hardware. Please see
our FAQs formore information: http://www.thefoundry.co.uk/support/licensing/faq/

• Quad-core x86-based processor.

• 250GB disk space available for caching and temporary files (or aminimumof 50GB if you're working on a small
project).

• At least 4GB RAM.

• Display with 1680 x 1050 pixel resolution.

• An NVIDIA or AMD graphics card with at least 1GB of RAM and OpenGL 3.2 support (seeWindows and Linux
Tested Graphics Cards).

NOTE: Displacement preview is currently only available on the cards and drivers that support OpenGL 4.0
or newer.

NOTE: In many Linux windowsmanagers, theAlt key is used by default as amousemodifier key. This can
cause problems in 3D applications whereAlt is used for camera navigation in 3D environments.

You can use key mapping to assign themousemodifier to another key, such as the (Super orMeta)
key, but themethod changes depending on which flavor of Linux you're using. Please refer to the
documentation on key mapping for your particular Linux distribution formore information.

Installation on Linux

Mari 2.6 is available to download fromourwebsite at www.thefoundry.co.uk/products/mari. The download is in a
compressed .run format.

1. Download the .run installation file fromourweb site.

2. Extract Mari from the .run archivewith the following terminal command, replacing [version number] with the
current version:
sudo ./Mari[version number]-linux-x86-release-64.run
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The installer displays the End User Licensing Agreement (EULA) and prompts you to accept it.

3. If you agreewith the EULA, enter y and press Return to accept the EULA. (If you don’t agreewith the EULA and
press n instead, the installation is canceled.)

By default, Mari is installed in an appropriately named folder in the current working directory.

4. That's it! Proceed with Launching on Linux.

NOTE: If you leave out sudo from the terminal command, you need to ensure that you have sufficient
permissions to install Mari under your current working directory or selected target directory.

After theMari application files have been installed, the installer also runs a post-installation script that
creates the following directory: /usr/local/foundry/RLM

If you don’t have sufficient permissions on the /usr/local folder for this directory to be created, the post-
installation script prompts you for your sudo password as necessary.

TIP: You can also use the following options after the terminal command when installingMari:
--info
This lets you seewhat the default installation directory is.

-- target MyMariDirectory
This lets you specify a different directory to install Mari to (in this case, MyMariDirectory).

--accept-eula
This lets you automate the installation so that you are not prompted to accept the EULA. Note that if you
use this option, you agree to the terms of the EULA. To see the EULA, please refer to Appendix D in the
Mari User Guide.

-- help
This lets you see additional help and installer options.

Here’s an example of the syntax using the --accept-eula option:
sudo ./Mari[version number]-linux-x86-release-64.run --accept-eula

Launching on Linux
1. Open a terminal.

2. Navigate to the directory you installed Mari to.

3. Enter ./mari.

4. If you haven’t installed a license forMari, you need to choose fromone of the options for Licensing on Linux.
Once you’ve done so, click Launch in theMari Licensing dialog.
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Mari checks forWindows and Linux Tested Graphics Cards, and if an untested graphics card configuration is
detected, a dialog displays warning you about it. Depending on the configuration detected, you have the option
toQuit or Continue and, in the case of configurations with known issues, also Ignore Permanently.

NOTE: If you ignore thewarning and runMari anyway, youmay experience instability or performance
issues. If a tested graphics card configuration is detected, Mari runs as normal.

5. If you are launchingMari for the first time, you are prompted to select a directory for its cache files. In the
Please Pick Cache Directory dialog, navigate to the directory you want to use and click Choose.

TheMari graphical interface displays.

Please note that the cache directory should be:

• empty

• local to themachine (not a network mount)

• as fast as possible

• a location that's not temporary (to avoid the data disappearing)

• a directory that the user has read and write permissions to.

Project cache locations are directories that Mari uses to store project data files. These directoriesmust be persistent;
not in temporary locations. If more than one cache location is specified, Mari spreads each project’s data files across
all locations. Once a project has been created for a given set of cache locations, that set must not be changed. In
order to move a project between different sets of caches, archive the project.

WARNING: Don’t add, remove, or amend cache locations once they have been set unless they are empty.
Once projects have been created for a given set of cache locations, that set must not be changed or project
corruption will occur.

NOTE: If theMARI_CACHE environment variable has been set, its value is used to determine the location
of the cache files. In this case, Mari does not prompt you to select the cache directory. Formore
information on environment variables that Mari understands, please refer to theMari User Guide.

TIP: You can also launchMari in verbosemode by using the following command:
./mari --verbose

This way, Mari provides a running log of each action that it performs. You can see this log in a terminal
window.
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Licensing on Linux

If you simply want to try out Mari, you can obtain a trial license, which allows you to runMari for free for 15 days.
See Install the License on page 21.

To useMari after this trial period, you need either a valid activation key, node locked license, or a floating
license and server running the Foundry Licensing Tools (FLT):

• Activation Keys and Node Locked Licenses - these are used to license applications on a singlemachine. They
do not work on different machines and if you need them to, you’ll have to transfer your license.

Node locked licenses, sometimes called uncounted licenses, do not require additional licensing software to be
installed. See LicensingMari on a SingleMachine formore information.

• Floating Licenses - these are used to license applications on any networked client machine. The floating license is
put on the server and is locked to a unique number on that server.

Floating licenses, sometimes called counted licenses, require additional software to be installed on a server to
manage the licenses and give themout to the client stations that want them. This software is called the Foundry
Licensing Tools (FLT) and can be downloaded at no extra cost fromourwebsite. See LicensingMari over a Network
formore information.

The instructions below run through both licensingmethods. You can also find amore detailed description in the
Foundry Licensing Tools User Guide available on our website: http://www.thefoundry.co.uk/support/licensing/tools/

Licensing Mari on a Single Machine

Obtain an Activation Key

To obtain a license, you'll need yourmachine's System ID (sometimes called Host ID or rlmhostid). Just so you know
what a System ID number looks like, here’s an example: 000ea641d7a1.

NOTE: Bear inmind that, for floating licenses, you'll need the System ID of the license server, not the
machines on which you intend to runMari.

There are a number of ways you can find out yourmachine's System ID:

• LaunchMari without a license, click Status, and then scroll down the error report until you see your System ID.

• Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. Your
System ID is displayed.

• Download the Foundry Licensing Tools (FLT) free of charge fromwww.thefoundry.co.uk/support/licensing/ and
then run the following command in a terminal shell:
/usr/local/foundry/LicensingTools7.0/bin/systemid

When you know your System ID, you can request a license for The Foundry products:
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• from The Foundry's Sales Department at sales@thefoundry.co.uk

• from the product pages on ourweb site, such as www.thefoundry.co.uk/products/mari/

• by launchingMari without a license and selecting:

• Buy Mari - opens aweb browser directly to The Foundry website to purchase a license.

• Try Mari - displays the 15-day trial license download screen. Enter your The Foundry account details or create
a new account and follow the on-screen instructions to receive a trial license.

NOTE: By default, if you have installed a temporary license, Mari displays a dialog at start-up alerting you
to the number of days remaining. If you want to disable this behavior, you can set the FN_DISABLE_
LICENSE_DIALOG environment variable to 1 to suppress thewarningmessage about imminent license
expiration. See Environment Variables That Mari Recognizes in theMari User Guide formore information.

Install the License

You are prompted to enter your activation key when you start Mari without a license. Mari skips this step if you’ve
already activated the application.

When you start the application before installing a license, a Licensing dialog displays an error, informing you that no
licensewas available. The installation process is dependent on what type of license you requested:

• License file - if you requested a license file, typically foundry.lic, this option allows you to browse to the file
location and install it automatically. See To install a license fromdisk formore information.

• Activation Key or license text - if you requested an Activation Key or license by email, this option allows you to
paste the key or license text into the Licensing dialog, which then installs the license in the correct directory. See
To install an Activation Key or license text formore information.

• A floating license - if you requested a floating license to supply licenses to multiple client machines, this option
allows you enter the server address that supplies the client licenses.

NOTE: Youmust install a floating license and additional software on the license server to use this option.

See Install Floating Licenses formore information.

TIP: If you later want to check the current status of your license (for example, to see if it’s a node locked
license or a floating license), select Tools > License in Mari to display theMari Licensing dialog.

To install a license fromdisk
1. Save the license file to a known location on disk.

2. LaunchMari.

The Licensing dialog displays.

3. Click Install License to display the available license installation options.
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4. Click Install from Disk.

5. Browse to the location of the license file.

6. ClickOpen to install the license automatically in the correct directory.

To install an Activation Key or license text
1. LaunchMari.

The Licensing dialog displays.

2. Click Install License to display the available license installation options.

3. Click Activation Key / License Text and then either:

• Enter theActivation Key string in place of Insert Activation Key Here. A license key typically looks
something like this:
mari-0101-77d3-99bd-a977-93e9-8035

OR

• Copy the license text and paste it over theCopy/Paste license text here string. License text typically looks
something like this:
LICENSE foundry mari_i 2015.1223 permanent 2 share=h min_timeout=30

start=23-jan-2015 issuer=sf issued=23-jan-2015 replace

_ck=6dd78e4c69 sig="60PG452MPDMMM6MJAMRGKNQAN3PEAK8JYTHN45022M0C98H

XFA9N7SAASMRABT8TUJ6FAMX8TWU0"

4. Click Install.

The license is automatically installed on yourmachine in the correct directory.

NOTE: Activation Keys require an internet connection. If you access the internet through a proxy server
and cannot connect to the activation server, youmay get an error dialog prompting you to either:

-Click Use Proxy to enter the proxy server name, port number, username, and password. This enables the
application to connect to the activation server and obtain a license. The license is then installed
automatically, or
-Click on theweb link in the dialog and use the System ID (also known as hostid) provided to manually
activate and install a license.

Licensing Mari over a Network

Obtain Floating Licenses

Alternatively, you can purchase a floating license key fromourwebsite.

1. Display your system ID by doing one of the following:
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• LaunchMari without a license, click Status, and then scroll down the error report until you see your System ID.

• Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. Your
System ID is displayed.

• Download the Foundry Licensing Tools (FLT) free of charge fromwww.thefoundry.co.uk/support/licensing/
and then run C:\Program Files\TheFoundry\LicensingTools7.0\ Foundry LicenseUtility.exe

2. Once you have provided us with your System ID number and a license key has been generated for you, you’ll
receive the license key in an e-mail or Internet download. The license key is contained in a text file called
foundry.lic. For information on what to do with the foundry.lic file, see Install Floating Licenses.

Install Floating Licenses

If you requested a floating license from The Foundry, you will receive your license key (foundry.lic) in an email or
internet download. You should also receive the Foundry LicenseUtility (FLU) application to help you install the
license key on the license servermachine. The servermanages licenses for the clientmachines on your network.

NOTE: The FLU is also available to download fromwww.thefoundry.co.uk/support/licensing/

1. Make sure you have saved both the license key (foundry.lic) and the Foundry LicenseUtility application in the
same directory.

2. Run the FLU application.

The license key automatically appears in the FLU window if the FLU and foundry.lic are in the same directory.

TIP: If they are not in the same directory, you can either copy and paste the contents of the license key or
drag-and-drop the file into the FLU window.

3. Click Install.

This checks the license file and, provided that the license is valid, installs it into the correct directory.

4. In order for the floating license to work, you will need to install the Foundry Licensing Tools (FLT) on the license
servermachine.

Formore information on how to install floating licenses, refer to the FLT User Guide, which you can download
fromourwebsite www.thefoundry.co.uk/support/licensing/

5. Once your license server is up and running, launchMari on the client machine.

6. Click Use Server and enter the server address in the field provided. The format for the server name is:
<port>@<servername>, for example, 30001@red.

NOTE: Youmust perform steps 5 through 7 on each client machine that requires aMari license from the
server.

TIP: If you later need to display theMari Licensing dialog again, you can select Tools > License in Mari.
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Further Reading
Formore information on licensingMari, displaying the System ID number, setting up a floating license server,
adding new license keys andmanaging license usage across a network, you should read the Foundry Licensing
Tools User Guide available on our website.

Mac OS X

Mac SystemRequirements
• Mac OS X 10.8.5 and 10.9.5.

WARNING: By default, when you first install Mac OS 10.8 or higher, the security preferences are set so
that any applications not downloaded from the Apple App Store can’t be installed.
To ensure that Mari installs correctly, navigate to System Preferences > Security & Privacy on your
Mac and select Anywhere for theAllow applications download from field.

• Quad-core x86-based processor.

• 250GB disk space available for caching and temporary files (or aminimumof 50GB if you’re working on a small
project).

• At least 4GB RAM.

• Display with 1680 x 1050 pixel resolution.

• NVIDIAQuadro 4000 or NVIDIA GeForce (Fermi Series) 650M.

Installation on Mac

Mari 2.6 is available to download fromourweb site at www.thefoundry.co.uk/products/mari. The download is in a
compressed .dmg format.

1. Download the .dmg installation file fromourweb site.

2. Double-click on the installation file and package to start the installation. Follow the on-screen instructions. By
default, Mari is installed to /Applications on the chosen hard disk.

3. That's it! Proceed with Launching onMac.

Installing Mari from the command line
1. Download the correct .dmg installation file fromourwebsite at www.thefoundry.co.uk.

2. Launch a Terminal window.
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3. To mount the .dmg installation file, use thehdiutil attach command with the directory where you saved the
installation file. For example, if you saved the installation file in Builds/Mari, use the following command:
hdiutil attach /Builds/Mari/Mari2.6v5-mac-x86-release-64.dmg

4. Enter the following command:
pushd /Volumes/Mari2.6v5/

This stores the directory path inmemory, so it can be returned to later.

5. To install Mari, use the following command:
sudo installer -pkg Mari2.6v5-mac-x86-release-64.pkg -target "/"

You are prompted for a password.

6. Enter the following command:
popd

This changes to the directory stored by the pushd command.

7. Finally, use the following command to eject themounted disk image:
hdiutil detach /Volumes/Mari2.6v5

NOTE: By running a silent install of Mari, you agree to the terms of the End User License Agreement. To see
this agreement, please refer to the Appendices in theMari User Guide, or run the installer in standard non-
silent mode.

Launching on Mac
1. Click Applications >Mari 2.6v5.

2. If you haven’t installed a license forMari, you need to choose fromone of the options for Licensing onMac.
Once you’ve done so, click Launch in theMari Licensing dialog.

Mari checks forMac OS X Tested Graphics Cards, and if an untested graphics card configuration is detected, a
dialog displays warning you about it. Depending on the configuration detected, you have the option toQuit or
Continue and, in the case of configurations with known issues, also Ignore Permanently.

NOTE: If you ignore thewarning and runMari anyway, youmay experience instability or performance
issues. If a tested graphics card configuration is detected, Mari runs as normal.

3. If you are launchingMari for the first time, you are prompted to select a directory for its cache files. In the
Please Pick Cache Directory dialog, navigate to the directory you want to use and click Choose.

TheMari graphical interface displays.

Please note that the cache directory should be:

• empty

• local to themachine (not a network mount)

• as fast as possible

• a location that's not temporary (to avoid the data disappearing)
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• a directory that the user has read and write permissions to.

Project cache locations are directories that Mari uses to store project data files. These directoriesmust be persistent;
not in temporary locations. If more than one cache location is specified, Mari spreads each project’s data files across
all locations. Once a project has been created for a given set of cache locations, that set must not be changed. In
order to move a project between different sets of caches, archive the project.

WARNING: Do not add, remove, or amend cache locations once they have been set unless they are
empty. Once projects have been created for a given set of cache locations, that set must not be changed or
project corruption will occur.

NOTE: If theMARI_CACHE environment variable has been set, its value is used to determine the location
of the cache files. In this case, Mari does not prompt you to select the cache directory. Formore
information on environment variables that Mari understands, please refer to theMari User Guide.

Licensing on Mac

If you simply want to try out Mari, you can obtain a trial license, which allows you to runMari for free for 15 days.
See Install the License on page 27.

To useMari after this trial period, you need either a valid activation key, node locked license, or a floating
license and server running the Foundry Licensing Tools (FLT):

• Activation Keys and Node Locked Licenses - these are used to license applications on a singlemachine. They
do not work on different machines and if you need them to, you’ll have to transfer your license.

Node locked licenses, sometimes called uncounted licenses, do not require additional licensing software to be
installed. See LicensingMari on a SingleMachine formore information.

• Floating Licenses - these are used to license applications on any networked client machine. The floating license is
put on the server and is locked to a unique number on that server.

Floating licenses, sometimes called counted licenses, require additional software to be installed on a server to
manage the licenses and give themout to the client stations that want them. This software is called the Foundry
Licensing Tools (FLT) and can be downloaded at no extra cost fromourwebsite. See LicensingMari over a Network
formore information.

The instructions below run through both licensingmethods. You can also find amore detailed description in the
Foundry Licensing Tools User Guide available on our website: http://www.thefoundry.co.uk/support/licensing/tools/
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Licensing Mari on a Single Machine

Obtain an Activation Key

To obtain a license, you'll need yourmachine's System ID (sometimes called Host ID or rlmhostid). Just so you know
what a System ID number looks like, here’s an example: 000ea641d7a1.

NOTE: Bear inmind that, for floating licenses, you'll need the System ID of the license server, not the
machines on which you intend to runMari.

There are a number of ways you can find out yourmachine's System ID:

• LaunchMari without a license, click Status, and then scroll down the error report until you see your System ID.

• Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. Your
System ID is displayed.

• Download the Foundry Licensing Tools (FLT) free of charge fromwww.thefoundry.co.uk/support/licensing/ and
then run /Applications/TheFoundry/LicensingTools7.0/Foundry LicenceUtility.app

When you know your System ID, you can request a license for The Foundry products:

• from The Foundry's Sales Department at sales@thefoundry.co.uk

• from the product pages on ourweb site, such as www.thefoundry.co.uk/products/mari/

• by launchingMari without a license and selecting:

• Buy Mari - opens aweb browser directly to The Foundry website to purchase a license.

• Try Mari - displays the 15-day trial license download screen. Enter your The Foundry account details or create
a new account and follow the on-screen instructions to receive a trial license.

NOTE: By default, if you have installed a temporary license, Mari displays a dialog at start-up alerting you
to the number of days remaining. If you want to disable this behavior, you can set the FN_DISABLE_
LICENSE_DIALOG environment variable to 1 to suppress thewarningmessage about imminent license
expiration. See Environment Variables That Mari Recognizes in theMari User Guide formore information.

Install the License

You are prompted to enter your activation key when you start Mari without a license. Mari skips this step if you’ve
already activated the application.

When you start the application before installing a license, a Licensing dialog displays an error, informing you that no
licensewas available. The installation process is dependent on what type of license you requested:

• License file - if you requested a license file, typically foundry.lic, this option allows you to browse to the file
location and install it automatically. See To install a license fromdisk formore information.
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• Activation Key or license text - if you requested an Activation Key or license by email, this option allows you to
paste the key or license text into the Licensing dialog, which then installs the license in the correct directory. See
To install an Activation Key or license text formore information.

• A floating license - if you requested a floating license to supply licenses to multiple client machines, this option
allows you enter the server address that supplies the client licenses.

NOTE: Youmust install a floating license and additional software on the license server to use this option.

See Install Floating Licenses formore information.

TIP: If you later want to check the current status of your license (for example, to see if it’s a node locked
license or a floating license), select Tools > License in Mari to display theMari Licensing dialog.

To install a license fromdisk
1. Save the license file to a known location on disk.

2. LaunchMari.

The Licensing dialog displays.

3. Click Install License to display the available license installation options.

4. Click Install from Disk.

5. Browse to the location of the license file.

6. ClickOpen to install the license automatically in the correct directory.

To install an Activation Key or license text
1. LaunchMari.

The Licensing dialog displays.

2. Click Install License to display the available license installation options.

3. Click Activation Key / License Text and then either:

• Enter theActivation Key string in place of Insert Activation Key Here. A license key typically looks
something like this:
mari-0101-77d3-99bd-a977-93e9-8035

OR

• Copy the license text and paste it over theCopy/Paste license text here string. License text typically looks
something like this:
LICENSE foundry mari_i 2015.1223 permanent 2 share=h min_timeout=30

start=23-jan-2015 issuer=sf issued=23-jan-2015 replace

_ck=6dd78e4c69 sig="60PG452MPDMMM6MJAMRGKNQAN3PEAK8JYTHN45022M0C98H

XFA9N7SAASMRABT8TUJ6FAMX8TWU0"

4. Click Install.
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The license is automatically installed on yourmachine in the correct directory.

NOTE: Activation Keys require an internet connection. If you access the internet through a proxy server
and cannot connect to the activation server, youmay get an error dialog prompting you to either:

-Click Use Proxy to enter the proxy server name, port number, username, and password. This enables the
application to connect to the activation server and obtain a license. The license is then installed
automatically, or
-Click on theweb link in the dialog and use the System ID (also known as hostid) provided to manually
activate and install a license.

Licensing Mari over a Network

Obtain Floating Licenses

Alternatively, you can purchase a floating license key fromourwebsite.

1. Display your system ID by doing one of the following:

• LaunchMari without a license, click Status, and then scroll down the error report until you see your System ID.

• Download the Foundry LicenseUtility (FLU) fromwww.thefoundry.co.uk/support/licensing/ and run it. Your
System ID is displayed.

• Download the Foundry Licensing Tools (FLT) free of charge fromwww.thefoundry.co.uk/support/licensing/
and then run C:\Program Files\TheFoundry\LicensingTools7.0\ Foundry LicenseUtility.exe

2. Once you have provided us with your System ID number and a license key has been generated for you, you’ll
receive the license key in an e-mail or Internet download. The license key is contained in a text file called
foundry.lic. For information on what to do with the foundry.lic file, see Install Floating Licenses.

Install Floating Licenses

If you requested a floating license from The Foundry, you will receive your license key (foundry.lic) in an email or
internet download. You should also receive the Foundry LicenseUtility (FLU) application to help you install the
license key on the license servermachine. The servermanages licenses for the clientmachines on your network.

NOTE: The FLU is also available to download fromwww.thefoundry.co.uk/support/licensing/

1. Make sure you have saved both the license key (foundry.lic) and the Foundry LicenseUtility application in the
same directory.

2. Run the FLU application.

The license key automatically appears in the FLU window if the FLU and foundry.lic are in the same directory.
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TIP: If they are not in the same directory, you can either copy and paste the contents of the license key or
drag-and-drop the file into the FLU window.

3. Click Install.

This checks the license file and, provided that the license is valid, installs it into the correct directory.

4. In order for the floating license to work, you will need to install the Foundry Licensing Tools (FLT) on the license
servermachine.

Formore information on how to install floating licenses, refer to the FLT User Guide, which you can download
fromourwebsite www.thefoundry.co.uk/support/licensing/

5. Once your license server is up and running, launchMari on the client machine.

6. Click Use Server and enter the server address in the field provided. The format for the server name is:
<port>@<servername>, for example, 30001@red.

NOTE: Youmust perform steps 5 through 7 on each client machine that requires aMari license from the
server.

TIP: If you later need to display theMari Licensing dialog again, you can select Tools > License in Mari.

Further Reading
Formore information on licensingMari, displaying the System ID number, setting up a floating license server,
adding new license keys andmanaging license usage across a network, you should read the Foundry Licensing
Tools User Guide available on our website.
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3 Mari Model Requirements
Mari has certainmodeling requirements that need to bemet in order to use geometry, whether the format of the
geometry is an Object, Ptex, or Alembic file format.

Model Requirements
Mari requires yourmodel files to be configured in a particular way.

Please bear inmind that Mari allows you to import and paint models withOverlapping UVs, like the one shown
below. However, if you paint on regions in the 3D views (orthographic or perspective), which also overlap in 2D UV
view, then youmay encounter painting artifacts, asMari is forced to choosewhich of the conflicting overlapping
paint strokes to bake down. To avoid this, you should only apply paint to one of the overlapped regions at a time in
the 3D views.

For example, if you paint a facewhere the left and right halves have beenmirrored with overlapping UVs, then you
should aim to only paint on one half of the face to avoid paint clashes.

NOTE: Paint clashing due to overlapping UVs cannot occur in theUV view, so you can always paint your
model in that view if you find that yourmodel is particularly tricky to paint in 3D views.

Models to paint in Mari should not have:

•UVs that go over 10 on the U axis - these are ignored.
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• Stacked UVs - these cannot be individually selected in UV view. If you do have stacked UVs and want to select an
individual UV, you need to select it in either Ortho or Perspective view first, and then switch back to UV view.

Models to paint in Mari cannot have:

•Negative UVs - painting on these is not possible.

For Ptex modeling, please see the Ptex Modeling Requirements in Mari section in theMari User Guide formore
information.

For Alembicmodeling, please see the Alembic Modeling Requirements in Mari section in theMari User Guide for
more information.
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4 The Mari Workspace
TheMari workspace consists of a themenubar, a canvas, toolbars, and a status bar. Palettes, for working with items
such as channels or shaders, can be either docked to the application ormade to float wherever you find themmost
useful.

What It Looks Like
Here is an illustration of theMari workspace that displays when you first open the program.

Workspace

Menubar To select Mari commands (many of which are also available using shortcut keys and/or
icons).

Toolbars To click icons for commonMari functions or settings.

Canvas Where you view and paint your geometry.

Tabs To switch between views.

Palettes Controls for viewing and changing different aspects of what's on the canvas.

Disk Usage Bar Displays howmuch of your cache disk has been filled.

Statusbar Information about the project generally, progress of long operations (such as baking), and
icons.
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5 Managing Projects
AMari project stores your work on geometries, and any associated textures. Mari's Project tab holds all the projects
you areworking on.

Creating a New Project
1. Do one of the following:

Select from
menubar

or click on
toolbar

or click on the
Project tab

or type
shortcut key

File > New New Ctrl/Cmd+N

TheNew Project dialog box displays.

2. Set the project'sName (for you to identify it only - this is not a filename).
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3. Select the geometry file for the project in the Path field. The drop-down lists the last 10 files selected, or you can

click to browse to a file.

Variousmesh options display in the dialog directly under Path, depending on whether you open an .obj, .ptx, or
.abc file.

• .obj files - you can select options for theMapping Scheme, Selection Sets, andMultiple Geometries Per
Object.

• .ptx files - you can select whether themesh data in the file represents a single new object or, when there are
multiple input files, if themesh data in each file represents a separate geometry in a single new object by
setting the Process each geometry file as a field.

Formore information on theMesh options, please see Create a New Project in the Ptex chapter of theMari
User Guide.

• .abc files - you can select options for theMapping Scheme andMerge Type, as well as set the objects that
are to bemerged in the object hierarchy.

Formore information on theMesh options, please see Create a New Project in the Alembic chapter of the
Mari User Guide.

4. If you are loading an animated sequence,Mesh options displays with the additional options Start Frame, End
Frame, Single Frame, and All Frames. These provide the frame range to view either user-defined start and
end frames, a single frame, or every frame. A Frame Offset also allows you to specify how the Alembic file is
loaded into Mari. This is available for .abc files only.
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5. To create a project frommultiple files, browse to a folder and select multiple files from the directory, before
clickingOpen.

The selected files are all shown in the Path field. These files are stored in the history as a single project under the
assigned name.

NOTE: It's only possible to create a project frommultiple files with .obj and .ptx files. You can only load
one .abc file when creating a new project.

6. In the Texture section, click to select which of the channels in the list to create. You can select a different
Category from the list – the set of channels updates with channels for your selected category.

TIP: Click Scan to makeMari scan the project's root path for any existing textures. If any textures exist for
your channels, Mari shows a green dot next to the channel. You can select to import these textures.

7. Click boxes under Create and Import to set the options. You can right-click to get a dropdownmenu allowing
you to easily create or import all the channels. As with the project name, the channelName is for you to identify
it only - when you export you can select a different name.

8. Choose Size, Type, and File Space from the dropdownmenus for each channel. Under Type, select Color for
anything color-dependent (andMari applies the viewer LUT automatically), or Scalar for amask or
displacement.

9. If you select a different Depth or resolution, file sizes can vary dramatically (for example, a 2k RGB “Byte”
texture file is 2MB - whereas a 4k “Float” is 172MB).

10. Set the Fill to fill a channel with a specified color by default.
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11. ClickOK.

Mari checks themodel for any errors that might prevent it fromprocessing; for example, touch border edges. A
Mesh Sanity Check dialog displays any warnings or errors. (Errors cancel opening themodel, but you can
continuewithwarnings.)

NOTE: For information onmodel requirements in Mari, refer to Mari Model Requirements on page 31.

12. Click to Continue.

Mari renders your selection and displays it on the canvas.

TIP: Depending on the size and complexity of textures, it can take several minutes the first time you load
them into aMari project. Once saved, however, the project should open quickly in future.

Opening Existing Projects
1. Click on the Projects tab.

This shows all the projects you have on your computer.

2. Double-click on the project to open.

NOTE: On project load, Mari looks formetadata that is over 250MB and discards anything that is over this
size. This is intended to strip corrupt and problematic data, and also affectsmetadata added via the
Python API.

Using the Command Line

You can also openMari and a specific, existing project, as well as archives using the command line. From theRun
dialog on your computer, use a command in the format of:

./mari /tmp/testproject.mra

By specifying the project name, UUID, folder path, or project.mri path, you openMari and the designated project.

The command line can also be used to run scripts that contain a Python call to open a project. From theRun dialog
on your computer, use a command in the format of:

./mari example_script.py

The example_script should contain the Python call to open a project.
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Saving Your Project
Do one of the following:

Select frommenubar or click on toolbar or type shortcut key

File > Save Ctrl/Cmd+S

TIP: Save your project often!
-Note that while your textures remain cached locally, saving does not export them, so export often too!
-If you don't need to save (no changes since the last save), the toolbar icon is gray.
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6 Configuring Your Workspace
TheMari workspace is completely configurable. As detailed on the pages that follow, you can customize how palettes
display, your own personalized sets of brushes and colors, and shortcut keys.

Palettes
Mari uses a number of palettes - windows that you canmove around your workspace, with specific information and
tools for working on your project. For example, theChannels palette shows all the channels in the project, and has
controls for editing the channels.

To open palettes:

Select from menubar or right-click on the menubar or toolbar and select

View > Palettes > <palette name> <palette name>

Tomove, size and arrange palettes:

To... Do this...

Undock andmove a
palette

Grab and drag it by its title bar to anywhere on your screen. (Or click to
undock, and then drag by its title bar).

Dock a palette to thewindow Move it to one of the edges of theMari window. A dotted line displays along
the edgewhere it can dock.

Dock a palette to another palette Move it over another undocked palette. A dotted line displays where it can
dock.

Size a docked palette Grab and drag the dotted bar along the bottomor side.

Size a floating palette Drag an edge or corner.

Stack palettes Drag and drop themdirectly on top of one another.
Tabs appear for selecting which of the stacked palettes to display.
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Shelves
The Shelf palette lets you store customized “shelves” of brushes, colors, and images. You can also share themwith
others.

Mari has the following kinds of shelves:

• TheMenu shelf stores seven items available from the F9 on-screenmenu. These itemsmust be numbered from 1-
7 to appear.

• The Personal shelf stores items you select and configure for all projects.

• TheBasic Brushes shelf stores a set of predefined basic brushes.

• TheHard Surface Brushes shelf stores a set of predefined hard surface brushes.

• TheOrganic Brushes shelf stores a set of predefined organic brushes.

• Customized shelves you create store items you select and configure for all projects.

Customizing Shelves

To add an item (brush, color, or image) to a shelf, drag it onto the shelf.
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7 Channels
Channels hold layers stacks, filled with paint layers, procedurals, and adjustments in your project. For example, a
project might have channels for diffuse color, displacement, or specularity, but each of those channels contain
individual layers for paint, masks, and filters. Channels can then be used in shader inputs so you can adjust the
amount of diffuse or specularity, among other things.

Adding a Channel to a Project
1. Do one of the following:

Select from the Channels menu or from the Channels
palette, click

or right-click on the Channels palette
and select

Add Channel Add Channel

TheAdd Channel dialog box displays, allowing you to set the options for the new channel.

2. Select a name, size, depth, color and file space, and base color for the channel (as with a new project), and click
Ok.

The new channel displays in theChannels palette.
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NOTE: If you areworking with a Ptex project, the patch Size option appears grayed out, as the .ptx format
doesn’t work with patches.

TIP: If there aremultiple objects in your project, there is noOk button in theAdd Channel dialog.
Instead, you need to choosewhether you want to add the channel to only the current object orAll
Objects.

Adding a Set of Channels
1. Do one of the following:

Select from the Channelsmenu or right-click on the Channels palette and select

Channel Presets Channel Presets

TheChannel Presets dialog box displays.

2. Select the Import and Resize options for the channels you're creating.

The list of channels at the bottomof the dialog box allows you to set whether you want to create the preset
channels from scratch or from an imported file. Set the channel options as you would in theAdd Channel
dialog.

3. If you have existing textures to import into the new channels, set theRoot Path andmake sure that the Files
for each channel show the correct texture files.

4. ClickOK to create and import the new channels.
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TIP: To toggle quickly between the last two selected channels (while in the painting canvas), press T.For
other options, such as locking or resizing a channel, right-click in theChannels palette or click on the
Channelsmenu.
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8 Layers
Layers are the source of your paint textures in a project. Layers are created as part of a layer stack, which is in turn
held within a specific channel. Each channel has a different layer stack that contains a new set of layers. You can
create paint layers, layermasks, adjustments, procedurals, and layer groups within the Layers palette.

Add a Layer to a Layer Stack
1. Do one of the following:

Select from the Layers menu or from the Layers palette,
click

or right-click on any layer in the Layers
palette and select

Add New Layer Add New Layer

A new layer appears in the Layers palette, above any other layers in the layer stack.

2. The paintable icon appears orangewhen the layer is selected and the paintable component is active.

Add a Mask to a Layer
1. Do one of the following:

Select from the Layers menu or from the Layers palette,
click

or right-click on any layer in the Layers
palette and select

Layer Mask > Add Mask > Reveal
All or From Alpha

Layer Mask > Add Mask > Reveal All or
From Alpha

A layermask is added to the selected layer in the Layers palette.

2. Themask icon appears orangewhen the layer is selected and themask component is active.

TIP: To switch back and forth between components on a layer, simply click on the component icons.
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Add an Adjustment to a Layer Stack
1. Do one of the following:

Select from the Layers menu or from the Layers palette,
click

or right-click on any layer in the Layers
palette and select

Add Adjustment Layer > any
adjustment from the dropdownmenu

Add Adjustment Layer > any
adjustment from the dropdownmenu

An adjustment layer appears in the Layers palette, above any other layers in the layer stack.

2. The adjustment icon appears orangewhen the layer is selected and the adjustment component is active.

Add a Procedural to a Layer Stack
1. Do one of the following:

Select from the Layers menu or from the Layers palette,
click

or right-click on any layer in the Layers
palette and select

Add Procedural Layer > any
procedural from the dropdownmenu
or sub-menus.

Add Procedural Layer > any procedural
from the dropdownmenu

A procedural layer appears in the Layers palette, above any other layers in the layer stack.

2. The procedural icon appears orangewhen the layer is selected and the procedural component is active.

Group Layers
1. Do one of the following:
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Select from the Layers menu or from the Layers palette,
click

or right-click on any layer in the Layers
palette and select

Add Empty Layer Group orGroup
Layers

Add Empty Layer Group orGroup
Layers

If you chose to add an empty layer group, this group is added as a new layer in the Layers palette, above any
other layers in the layer stack.

If you chose to group existing layers together in the layer stack, youmust have one ormore layers selected. This
group is created at the point of the top-most selected layer.

2. To add new layers to an empty layer group, simply drag existing layers into the group.

Alternatively, once you’ve added a layer to the group, select any layer within it and Add New Layer.

3. All layers within a groupmaintain any component icons associated with them. The group parent layer has a

folder icon to distinguish it as the group layer.
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9 Shaders
Shaders control howMari displays themodel on the canvas. Mari's default shaders show the paint in either the
Current Channel, Current Layer and Below, Current Layer, or Current Paint Target. You can also create
your own custom shaders by combining diffuse and specular shader types then setting up channels in the shader
component inputs to specify how they appear in the shader.

Create a Shader
1. Do one of the following:

Select from the Shading menu or from the Shaders
palette, click

or right-click on the Shaders palette and
select

Add New Shader > any shader from
the dropdownmenu

any shader from the dropdownmenu

The new shader displays in the list, with shader components shown at the bottomof the palette.

2. Instead of selecting shader types from themenu (Phong orBlinn, for example) you can specify the diffuse and
specular by selecting Choose Diffuse and Specular from themenu.

TheCreate Shader dialog appears.
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Select yourDiffuse and Specular shader options and clickOK.

3. All shaders are created with theCurrent Channel in theDiffuse Color shader component. You can change this,
and set the other components by clicking on the dropdownmenu next to the component name and selecting
the channel.

4. If you haven’t yet created a channel to use in a specific shader component, click the add channel icon next
to the shader component.

TheAdd Channel dialog box appears. Select the options for your channel from the dialog and clickOk.

5. Once you’ve set a channel to the shader component, adjust the value or level of the component, using the
sliders.

You can add asmany shaders as you need and compare themor switch back to the default shaders at any time.

TIP: Shaders don’t affect the contents of the channels. For example, if you have a shader with channels set
in both the diffuse and specular color inputs, themodel on-screen displays the effects of both channels.
However, the channels are still separate and contain different data.

TIP: If you build a shader that takes data frommultiple channels, it can be hard to rememberwhich
channel you're currently editing. In this case, you can switch back to one of the default shaders, which just
shows the contents of the current channel, layer and below, layer, or paint target.
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10 Changing the View
As described below, Mari includes features for 3D navigation to view yourmodel from various angles and
perspectives, change the lighting on themesh, and change the resolution of textures.

3D Navigation

To...

Zoom in and out Alt+Ctrl/Cmd-click and drag, OR Right-click and drag

Pan left and right Alt+Shift-click and drag, ORMiddle-click and drag

Rotate themodel Alt+left-click and drag

Spin the camera Alt+Ctrl/Cmd+R+left-click and drag

NOTE: In many Linux windowsmanagers, theAlt key is used by default as amousemodifier key. This can
cause problems in 3D applications whereAlt is used for camera navigation in 3D environments.

You can use key mapping to assign themousemodifier to another key, such as the (Super orMeta)
key, but themethod changes depending on which flavor of Linux you're using. Please refer to the
documentation on key mapping for your particular Linux distribution formore information.

TIP: By default, Mari usesmomentumwhen you aremoving the view. When you let go of themouse
button, themodel slowly coasts to a stop. You can turn this behavior off so that themodel only moves
when you are holding themouse button down.

To do so, change the settings in the preferences by uncheckingMomentum Enabled via Edit >
Preferences > Navigation.

The navigation toolbar also provides the ability to control panning, zooming, rolling, and orbiting, with various
settings for each. You can easily access the toolbar, shown below, at any time using the following buttons:
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• Reset navigation settings to default.

• Enable panning to move themodel on the screen.

• Enable zooming to zoom in or out on themodel.

• Enable rolling to turn on themomentum system.

• Enable orbitingmimics the orbiting system inMaya and allows you to move the camera around themodel.

• Disable rotational snapping gives options to turn on and change the angle at which the camera view snaps to (45
degrees or 90 degrees).

You can also use the keys 1-6 to switch between preset views (left, right, top, bottom, front, and back).

In theUV view, you can also rotate or reset themodel for easier viewing and painting. Press 1 to reset themodel
back to its default position. Press 2, 3, and 4 to rotate themodel counter-clockwise in 90-degree increments from
the default position.

PressHome to cycle between hiding all palettes, hiding docked palettes and showing hidden palettes.

Use the tabs at the top of the canvas to switch between:

•UV - a grid view showing theUV patches.

•Ortho/UV - a splitscreen showing theUV patches and the orthographic view.

• Perspective - a perspective camera view, or

•Ortho - an orthographic camera view.

TIP: You can also use the , , and toolbar buttons or the F10, F11, and F12 keyboard
shortcuts to activate a particular view on any tab.

Lighting
You can change the lighting on themainmesh by clicking on the toolbar:

Flat Basic Full
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Flat Basic Full

Mari has five lights: four basic point lights, which appear on the drawing canvas, and one environment light.

You can set the light details in the Lights palette. Mari uses these in theBasic and Full lightingmodes:

• To turn a light on or off, click on the icon in the list, or use theGeneral > On checkbox.

• To change a light, click on it in the Lights list, and then set the color and strength.

• Select whether the light is fixed to the Scene or Camera.

• To move a light around, select the Pan Object tool , then click and drag the light around on the canvas.

• To move a light to the camera position, click on the icon on the Lights palette, or right-click on the light and
selectMove to Camera Position.

You can toggle the shadows on and off in the Lighting toolbar:

Shadows on Shadows off

This simply toggles the display of shadows on the canvas, but does not disable shadow processing.

• You can control Shadow Rendering through the option on the Lights palette.

• Toggle shadows by clicking on the Shadows icon in the Lighting toolbar or the Shadingmenu.

• If you want to enable shadow processing, you need to enable theDepth Projections checkbox under
Preferences > GPU |Depth Projection. By default, this preference is disabled.
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11 Painting
Painting in Mari is similar to other standard paint programs. Paint using the various tools, then bake it onto your
model. Most tools work on unbaked paint, but one or two also work directly on the baked paint on the surface. Each
tool has a set of keys that control how it works. By default, the option keys for the current tool are shown on-screen
at the top of the canvas.

Paint Tools
To select a tool:

Select from your shelves or the Tools toolbar:

Paint tools

Select Marquee select Transform paint buffer
Zoompaint buffer

Pan object Vector Inspector Blur Warp

Slerp Pinup Paint Vector Paint

Erase Paint through Paint gradient Clonestamp

Towbrush Color picker/ Pixel
analyzer
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Painting a Constant Color
1. Click to select the Paint tool.

2. Click and drag to paint on themodel.

TIP: You can paint a straight line by clicking one end point, moving the cursor, pressing Shift and clicking
the second end point, or pressing Shift and holding down themouse button whilemoving horizontally or
vertically.

Customizing Your Brush
1. Open theBrush Editor palette.

TheBrush Editor displays.

TIP: Resize the brush editor palette to minimize scrolling. There aremany options for customizing your
brush, including setting values for Paint, Pressure, Radius, Rotation, Bitmaps to use,Geometry and
Noise. You can test the brush in the scratch pad at the bottomof the palette.

2. You can select a brush to modify from those available in your Shelves.

3. When you have finished editing a brush, click to add it to the selected shelf.
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“Painting Through” an Image
1. Open the Image Manager palette.

2. To load an image, click , navigate to and select the image file, and clickOpen.

A thumbnail of the image displays, along with information about the selected image.

3. In the Tools toolbar, click (the Paint Through tool).

4. Drag and drop the image from the Image Manager to the canvas.

5. Adjust the image size and position:

To... Do this...

Resize Grab and drag its edges or corners, or press Ctrl/Cmd+Shift then click and drag.

Move Grab the “handle” in the center of the image (or press Shift and click anywhere on
the image), and drag.

Rotate Click and drag outside the image, or press Ctrl/Cmd and drag inside the image.

Press Shift when dragging outside the image to rotate in increments.

Crop Double-click the image in the Image Manager, drag the area you want to crop, and

click .

Change the opacity In the Tool Properties palette, select Texture > Preview, and change the
PreviewAlpha (enter a number or drag the slider). Pre-multiply alpha if your image
has transparency.

Reset the image In the Tool Properties palette, select Texture > Transform > Reset.

6. Paint!

TIP: You can quickly switch between the Paint and PaintThrough tools by pressing P andU. To hide the
image, hold the ? key, to paint thewhole image onto themodel in one step, press the ' (apostrophe) key.
Toggle repeat image to paint past the edge of the floating image and have the paint continue, by pressing
the ; (semicolon) key.
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Clone Stamping
1. Click to select the clone stamping tool.

2. Use the Sourcemenu on the toolbar to select where to take the clone source from. You can select the current
paint target, an image, or any of the paint layers in the project.

3. If you’re using an image as your clone source, hold down theCtrl/Cmd key over the image and click to select the
clone source point.

TIP: When cloning from a paint layer, you can clone directly from the surface. In thismode, the tool clones
the paint from the paint layer surface straight up into the paint buffer directly above that point. This lets
you copy themodel's surface into the paint buffer so you can edit it and then re-bake.

To use thismode, hold down Ctrl+ (orWindows key) when you click to set the origin point. ForMac,
this shortcut is Cmd+Ctrl.

4. Paint to clone your selection on themodel.

Moving and Warping Paint

Tomove paint on themodel before baking:

1. Click to select the transform tool.

2. Left-click anywhere on the paint buffer and drag to move the painting around on themodel.

3. Ctrl/Cmd+left-click and drag to rotate the painting, or left-click and drag outside the paint buffer.

4. Ctrl/Cmd+Shift+left-click and drag to resize the painting, or grab the corners of the paint buffer and drag.

TIP: The paint buffer is visible on-screen as awhite box, but it may be larger than the viewwindow and not
visible. It becomes obvious if youmove or resize the painting. To reset the paint buffer to its default values
click theReset button in the Painting palette under Paint Buffer > Transform.
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To warp paint before baking:

Using this tool... You can...

Warp
Shift-click and drag to create awarp grid. Click and drag the points around
to warp the paint. To increase or decrease the grid resolution, press the up
or down arrow keys.

Slerp
Use the SlerpModemenu on the toolbar to set themode (from Pull,Grow,
Shrink, orRotate). Click and drag to apply your effect. Erase distortion by
selecting the Erasemode.

Pinup
Shift-click to set “pins”. Then click and drag to move the pins. You can use
pins to protect parts of the paint that you don't want affected by the
distortion.

Baking Paint onto theModel
To bake paint onto yourmodel:

1. Make sure all patches you want to bake are selected.

2. Do one of the following:

Type shortcut key or click on statusbar icon

B

TIP: Whenever you change your view of themodel, it bakes automatically. You can change this setting in
the Projection palette if required.

Blurring Baked Paint
1. Click to select the blur tool.

2. Left-click and drag to blur paint baked on the surface.

TIP: As with the paint tools, you can edit the blur brush tip. When you have finished blurring the paint, you
need to bake.
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12 Exporting and Importing
You can export and import both channels and layers in your project, both in ’flat’ formats, such as .png, and in
layered formats, such as .psd or .psb. This is especially useful when exportingmultiple layers or channels that you
don’t want to take up a lot of space, or when you want to use the final output of a channel in another application.

Exporting Channels
To export the current channel, select a single channel to export and do one of the following:

Select from theChannelsmenu or right-click on theChannels palette and select

Export > Export Current Channel Export > Export Current Channel

Export > Export Current Channel Flattened Export > Export Current Channel Flattened

The Export dialog box displays.

To export all channels in your project, do one of the following:
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Select from theChannelsmenu or right-click in Channels palette and select

Export > Export All Channels Export > Export All Channels

Export > Export All Channels Flattened Export > Export All Channels Flattened

The Export dialog box displays.

To export everything in your project, including all layers, channels, and patches, do one of the following:

Select from theChannelsmenu or right-click in Channels palette and select

Export > Export Everything Export > Export Everything

Export > Export Everything Flattened Export > Export Everything Flattened

The Export All dialog box displays.

NOTE: All of themethods for exporting textures shown above follow the same instructions once they
reach the Export dialog.

1. On the Sequence tab, enter the Path where you want to store the export, or use the browse panes (the
navigation panes below) to browse to it.

2. If you are looking for a specific folder or file, you can use the Filter field to specify a name or file format to
search for.

3. For the Template, either use the default filename template or edit it as required.

4. Click Export All Patches (to export all patches in the current channel) to export with the settings you’ve
selected

NOTE: If Small Textures is enabled, Mari exports any patches that you haven't painted yet, or have
painted as a single color, as 8x8-pixel textures. When you start to paint on a particular patch, Mari exports
it as the correct size.

NOTE: The steps above assume you are exporting a sequence of patches with the udim number (1001,
1002, etc.) in the file names. Formore information on howUDIM numbers are allocated to patches, please
see the section on Using UDIM Values in the Working with Patches chapter of theMari User Guide.
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NOTE: If you'd rather assign individual files to each patch, you can do so on theNamed Files tab of the
Export Channel dialog. Click the buttons on the right to open a file browser and pick a file for each patch.
Then, click Export All Patches to export the files. Note that by default theNamed Files tab doesn't
display if you havemore than 20 patches in your object. To change this number, you can use the Patch
Cutoff preference or set theMARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a new
value.

TIP: Make sure you check the path and name carefully, especially if you have been swapping between
assets - Mari defaults to the last place you've exported. Don't risk overwriting your textures!

Exporting Layers
To export selected layers, select any layers you want to export and do one of the following:

Select from the Layersmenu or right-click on the Layers palette and select

Export > Export Selected Layers Export > Export Selected Layers

Export > Export Selected Layers Flattened Export > Export Selected Layers Flattened

The Export dialog box displays.

To export all layers in the channel, do one of the following:

Select from the Layersmenu or right-click in Layers palette and select

Export > Export All Layer Export > Export All Layers

Export > Export All Layers Flattened Export > Export All Layers Flattened

The Export All dialog box displays.

NOTE: All of themethods for exporting layers shown above follow the same instructions as for exporting
channels once they reach the Export dialog. These instructions begin with step 1 in Exporting Channels.

Importing Channels
To import into your current channel’s layer stack, do one of the following:
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Select from the Channelsmenu or right-click in Channels palette and select

Import > Import into Layer Stack Import > Import into Layer Stack

The Import dialog box displays.

1. Enter the Path to the files to import, or use the browse panes (the two left-hand navigation panes) to browse to
them.

2. If you are looking for a specific folder or file, you can use the Filter field to specify a name or file format to
search for.

3. For the Template, either use the default filename template or edit it as required.

4. To import all patches from theirmatching files, click Import All Patches. This imports files with the settings
you’ve selected.

NOTE: The steps above assume you are importing a sequence of patches with theUDIM number (1001,
1002, etc.) in the file names. Formore information on howUDIM numbers are allocated to patches, please
see the section on Using UDIM Values in the Working with Patches chapter of theMari User Guide.

NOTE: If you'd rather assign individual files to each patch, you can do so on theNamed Files tab of the
Import Channel dialog. Click the buttons on the right to open a file browser and pick a file for each patch.
Then, click Import All Patches to import the files. Note that by default theNamed Files tab doesn't
display if you havemore than 20 patches in your object. To change this number, you can use the Patch
Cutoff preference or set theMARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a new
value.

To import into a new channel, do one of the following:
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Select from the Channelsmenu or right-click in Channels palette and select

Import > Import into New Channel Import > Import into New Channel

TheAdd Channel dialog box displays.

1. Follow the instructions for setting up a new channel in Adding a Channel to a Project on page 41, and when
you’ve finished, clickOk.

The Import dialog box displays.

2. Enter the Path for the files to import, or use the browse panes (the two left-hand navigation panes) to browse to
them.

NOTE: The steps above assume you are importing a sequence of patches with theUDIM number (1001,
1002, etc.) in the file names. Formore information on howUDIM numbers are allocated to patches, please
see the section on Using UDIM Values in the Working with Patches chapter of theMari User Guide.

NOTE: If you'd rather assign individual files to each patch, you can do so on theNamed Files tab of the
Import Channel dialog. Click the buttons on the right to open a file browser and pick a file for each patch.
Then, click Import All Patches to import the files. Note that by default theNamed Files tab doesn't
display if you havemore than 20 patches in your object. To change this number, you can use the Patch
Cutoff preference or set theMARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a new
value.

Importing Layers
To import into the current layer, do one of the following:

Select from the Layersmenu or right-click in Layers palette and select

Import > Import into Layer Import > Import into Layer

The Import dialog box displays.

To import as a layer in the current layer stack, do one of the following:

Select from the Layersmenu or right-click in Layers palette and select

Import > Import into Layer Stack Import into Layer Stack

The Import dialog box displays.
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1. Enter the Path for the files to import, or use the browse panes (the two left-hand navigation panes) to browse to
them.

2. If you are looking for a specific folder or file, you can use the Filter field to specify a name or file format to
search for.

3. For the Template, either use the default filename template or edit it as required.

4. Click Import All Patches (to import all patches from the file) to import with the settings you’ve selected

NOTE: The steps above assume you are importing a sequence of patches with theUDIM number (1001,
1002, etc.) in the file names. Formore information on howUDIM numbers are allocated to patches, please
see the section on Using UDIM Values in the Working with Patches chapter of theMari User Guide.

NOTE: If you'd rather assign individual files to each patch, you can do so on theNamed Files tab of the
Import Channel dialog. Click the buttons on the right to open a file browser and pick a file for each patch.
Then, click Import All Patches to import the files. Note that by default theNamed Files tab doesn't
display if you havemore than 20 patches in your object. To change this number, you can use the Patch
Cutoff preference or set theMARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a new
value.
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13 About the Tutorials
As part of the Getting Started Guide, there are several tutorials that give you a chance to try your hand at setting up
a project and getting started with the basics. The tutorials are self-paced but designed to take roughly 10 to 45
minutes each. Youmight find yourself breezing through onewhile spending a lot of time on another to soak up
details you're not quite sure about.

The tutorials included in thismanual are:

• Tutorial 1: Setting up a Project

• Tutorial 2: Setting the View

• Tutorial 3: Painting!

• Tutorial 4: Painting Through and Clone Stamping

• Tutorial 5: Exporting and Importing

Download Sample Files
Sample files are provided for usewith all of the tutorials. You can download these files fromourweb site at
www.thefoundry.co.uk/mari and try Mari out on them. From theMari product page, click on theDemo Assets link.

Tutorial Format
Mari tutorials include steps, which are the specific instructions for you to perform. Steps are organized into major
actions. For example, all the steps involved in loading the geometry when creating a project are grouped on a page
with the title “Load geometry”. The individual steps are numbered, and describewhat you should do and what
happens in Mari. For example:

1. Next, to bring in the geometry, click .

The PickMesh dialog box displays.

Note that the response to each step (what happens when you do it) is in italics, and the name of any dialog box or UI
item that displays as part of that response is bold.
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Tutorial 1: Setting up a Project
This lesson teaches you what Mari projects are, and how to create them.

What You Should Know Before Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read theMari Getting Started Guide up to this point

• that you know how to start Mari (see Launching onWindows, Launching on Linux, or Launching onMac).

Resources You Need to Complete This Lesson

To complete this lesson, you need access to a computer that can runMari, and the following sample file:

• blacksmith_body.obj

How Long Should It Take?

Plan on spending about 20 minutes to complete this lesson.

About Mari Projects
AMari project holds your work on geometries and associated textures. Once you've created aMari project, you can
work on it, save and close - and then re-open it to continueworking on the same textures later.

Projects also hold other items, such as projectors, shaders, and so on. Mari saves some settings at the project level.
For instance, each project has:

• a project shelf, to hold brushes, colors, and images for you to use specifically in that project, and

• contents of the various palettes - Image Manager, BrushEditor, and so on.
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When you first create a project, you can specify its parameters, including:

• the details (such as resolution and color depth) of the initial channel in the project.

• the range of animation frames to import.

Steps for Creating Mari Projects

To create aMari project, follow these steps:

1. Open aNew Project

2. Specify Project Options

3. Load Geometry

4. Save Your Project

Open a New Project
1. Start Mari.

TheMari workspace displays, showing the Projects tab. This holds all the projects you have been working on.

2. As withmost commands in Mari, you can select theNew Project option a few different ways:

• from the Filemenu, select New,

• click on the toolbar,

• click theNew button,

• right-click in the Projects tab and select New from the dropdownmenu, or

• press theCtrl/Cmd+N shortcut key.

Pick any one of the options above.

TheNew Project dialog box displays.
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TheNew Project dialog box has three parts:

•Name - a name for your project.

• Geometry - themodel you'll be painting on.

• Texture - parameters for the textures you'll be creating.

Next we'll specify the name and texture options, and then select the geometry.

NOTE: Formore information on what kind of modelsMari expects, seeMari Model Requirements.This
model displays with no errors. Mari loads the geometry and displays it in your workspace.

TIP: Formore on the different options in theNewProject dialog box - and other dialog boxes illustrated
in this tutorial, see theMari Reference Guide.

Specify Project Options
1. For the project Name, type 1-Blacksmith.

2. For the Texture options, right-click on the list of channels and select Create All.
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Load Geometry

1. Next, to bring in theGeometry, click .

The Pick Mesh dialog box displays.

2. Navigate to your tutorial folder, click to highlight blacksmith_body.obj, and clickOpen.

NOTE: When you load geometry,Mesh Options appear for themodel you’ve entered in the Path field.
For this tutorial, leave themesh options as they are, but formore information on theMesh Options refer
to theNew Project Dialog chapter in theMari Reference Guide and the Ptex chapter in theMari User Guide.

3. ClickOk.

Mari conducts a quick “sanity check” on themodel to make sure there are no obvious problems. If there are any
problems, it displayswarnings or errors. If there arewarnings, you can continue. If there are errors, youmust
stop and fix them.
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TIP: Depending on the size and complexity of amodel, it can take several minutes the first time you load it
into aMari project. Once saved, however, the project should open quickly in future.

Save Your Project
Save your project - again you can do this a fewways:

• from the Filemenu, select Save,

• click on the toolbar, or

• press the shortcut key Ctrl/Cmd+S.

Mari saves the project into its cache directory. Now, if you click on the Projects tab at the top of the screen, you see
your new project in the list.

Where Do You Go from Here?
At this point, you should have a basic idea of what aMari project is and how to create one. You learned how to:
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• Name the project.

• Set texture options.

• Load geometry.

• Save the project.

Next, you'll use this project to practice some basics about setting the camera and lighting on the geometry in your
project, before you begin to paint on it. When you're ready, proceed to Tutorial 2: Setting the View.

TUTORIAL 1: SETTING UP A PROJECT | WHERE DO YOUGO FROM HERE?



Tutorial 2: Setting the View
This lesson teaches you how to open aMari project, and then set the view and lighting on your geometry (before
painting on it).

Setting the view includes:

• rotating

• zooming in or out

• panning

• viewing from six basic directions

• displaying a split view showing a 3D view plus UV patches

Setting the lighting includes:

• picking “flat”, “basic”, or “full” lighting,

• toggling shadows on or off,

• moving lights around and adjusting their properties.

What You Should Know Before Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read theMari Getting Started Guide up to this point

• that you know how to start Mari (see Launching onWindows, Launching on Linux, or Launching onMac)

• that you have completed Tutorial 1: Setting up a Project.

Resources You Need to Complete This Lesson

To complete this lesson, you need access to a computer that can runMari, and the following sample file:

• 1-Blacksmith - theMari project file you created in Tutorial 1

How Long Should It Take?

Plan on spending about 25 minutes to complete this lesson.
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About Mari View and Lighting
The view in Mari is a view on the object you are painting. By default, Mari has four types of view:

•UV - this gives you a “flat” view of the patches in themodel.

• Perspective - this show themodel as awhole in 3D space, through a perspective camera.

•Ortho - this shows themodel as awhole in 3D space, through an orthographic camera.

•Ortho/UV - this is a split screen, showing both theUV patches and the orthographic view.

UV View Ortho View

Ortho/UV View

You canmove each view separately.

TIP: You can also use the , , and toolbar buttons or the F10, F11, and F12 keyboard
shortcuts to activate a particular view on any tab.

Within the views, you can:

• Spin or rotate themodel (3D views only). Spinning turns themodel on one axis, while rotating lets you turn the
model in all three axes. Think of spinning as like turning themodel on a turntable, while rotate is turning it around
inmidair.

• Pan to move the view across themodel.

• Zoom in or out.

• Focus on a selected patch.
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You separately configure the lighting on the object by selecting preset settings for “flat”, “basic”, or “full”, or
specifying fine details such as shading parameters and separate lighting for each of the four configurable lights.

Steps for Setting the Camera and Lighting

To set the camera and lighting, follow these steps:

1. Open Your Project

2. Adjust the View

3. Adjust the Lighting

Open Your Project
1. Start Mari.

TheMari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open it.

Your project opens and switches to theOrtho view.
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Adjust the View
To adjust the view on your project, you can zoom, pan, rotate, select one of six preset views, display yourmodel and
patches in a split screen, or use perspective and orthographic views.

1. To zoom out and in, hold down theAlt key, right-click and drag the cursor to the left and right.

2. To pan, hold down theAlt key andmiddle-click (or hold Alt and Shift and left-click and drag).

3. To rotate, hold down theAlt key and left-click and drag.

TIP: You can also “spin” around a fixed point by pressing Ctrl/Cmd+R, left-clicking, and dragging. When
you rotate or spin, the pivot point is located in the center of the current view.

4. To view from six basic preset angles (camera “left”, “right”, “top”, “bottom”, “front”, and “rear”), press 1, 2, 3, 4, 5,
or 6, or select the angle from theCameramenu.
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5. To see a flat view of theUV patches on themodel, click theUV tab.

To see a split screen showing both theOrtho and UV views, click theOrtho/UV tab.
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6. To see a perspective view of yourmodel, click the Perspective tab (or press F11).

In the Perspective view, you can alter yourmodel’s appearance in the viewer by enteringNear, Far, and FoV
values in theCanvas toolbar. See Setting the Perspective Camera Details in the Customizing the View chapter in
theMari User Guide formore information.

7. To see an orthographic view of yourmodel, click theOrtho tab (or press F10). This is the default viewmode, that
is, the view you seewhen you start Mari.

NOTE: Themodel is in the same position in steps 7 and 8; only the viewmode has changed. Notice that
themodel’s arms appear closer to the body due to the application of perspective.

8. To switch the view to display all selected patches, pressA.

If you don't have any patches selected, the view focuses on themodel as awhole (changing to show thewhole
model).

TIP: If you find that the view starts cutting through the front clipping plane, try pressingA.

9. To center the view at a particular place on themodel, move the cursor there and press F.
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At the current size and angle, the view changes to focus on the cursor point. If you hover the cursor over the
canvas where no part of the object is present, pressing F brings the focus on the entire object.

TIP: You can paint in any of the views.

Moving the view bakes the current paint if Bake Behavior is set to AutoBakeAndClear. You can set this
on the Projection palette, under Projection (if you can't see the Projection palette, select View >
Palettes > Projection to display it).

EXPERIMENT: Play around with zooming, panning, and rotating the camera. Try changing betweenOrtho
and Perspectivemodes. Notice that objects closer to the camera distort farmore than objects further
away?

Adjust the Lighting
Mari comeswith three lighting presets: flat, basic, or full. In basic and full modes, you canmove the lights around the
model.

1. To change the lighting:

• from the Shadingmenu, select Flat, Basic, or Full, or

• click , , or on the toolbar.
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2. Notice the four lights on the canvas (youmay need to select the Pan Object tool to see them).

By default, the lights appear as gray spheres .

3. To move a light around, select the Pan Object tool (if you didn't already). Click on a light and drag it
around the canvas.

As youmove the light, you can see the effect on themodel.

4. You can also make fine adjustments to lighting using the Lights palette. If it's already open, click the Lights tab
to give it focus; or if it's closed, right-click in the toolbar area on top of theMari workspace and select Lights to
open it.

The Lights palette displays details of four basic lights, which you can enable or disable, and customize by
adjusting their Color and Fixed To information, and an environment light, which you can adjust to add
environment lighting from an image. For details, see the Customizing the View chapter in theMari User Guide.

5. Lighting can be relative to the Scene or a Camera:

• Scene (default) - the light is fixed to themodel, for example if a light is set at themodel's back, it always points
at themodel's back, nomatter how youmove the view.
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• Camera - the light is fixed to a camera view, for example you can have a light always shining from above the
camera, allowing you to move themodel around and cast light on different areas.

6. A single light can bemoved to the position of the current camera by right-clicking the light and selectingMove
to Camera Position or clicking on theMove to Camera Position icon when the desired light is selected.

7. Select theRender Shadows checkbox to produce shadows for an individual light.

Shadows render and display immediately for the selected light.

8. Shadows can be enabled or disabled in the display by toggling the Shadows icon in the Lighting toolbar
or the Shadingmenu.

NOTE: Mari saves custom lighting with the project. If you need the same lights in another project, you
need to set themup separately.

Where Do You Go from Here?
At this point, you should have a basic idea of the different options for adjusting the view and lighting on yourmodel.
You learned how to:

• zoom, pan, and rotate

• select one of six preset angles

• toggle split view

• change to flat, basic, or full lighting

• move and configure lights.

Now that you know how to create a project, load geometry, and adjust the position of the view and lighting, you can
(finally) begin to paint! When you're ready, proceed to Tutorial 3: Painting!.
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Tutorial 3: Painting!
This lesson teaches you the basic steps to painting on amodel in Mari. This includes, selecting a brush, selecting a
color, and painting with that brush and color.

What You Should Know Before Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read theMari Getting Started Guide up to this point

• that you know how to start Mari (see Launching onWindows, Launching on Linux, or Launching onMac)

• that you have completed Tutorial 1: Setting up a Project and Tutorial 2: Setting the View.

Resources You Need to Complete This Lesson

To complete this lesson, you need access to a computer that can runMari, and the following sample file:

• 1-Blacksmith - theMari project file you created in Tutorial 1 and configured in Tutorial 2

How Long Should It Take?

Plan on spending about 25 minutes to complete this lesson.

About Painting in Mari
Painting in Mari is similar to painting in other standard paint programs - you can select and configure both brushes
and colors, and then use them to paint an object. In Mari, you configure brushes through theBrushEditor and
colors through theColorPalette. You also have the option of saving colors and brushes to your Shelf for easy
access. TheMari Shelf comeswith lots of presets, as well as any items you have created or customized for yourself
(and saved there).

After you paint (also as with other programs), in Mari you need to bake the paint buffer into the object. Mari
includes various ways of baking onto selected patches, including an Autobake option that bakes by default every
time youmove the camera.
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Steps for Painting in Mari

To paint in Mari, follow these steps:

1. Open Your Project

2. Open the Colors and Shelf Palettes

3. Select a Color

4. Select a Brush

5. Paint!

6. Bake Your Painting

Open Your Project
1. Start Mari.

TheMari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open it.

Your project opens and switches to theOrtho view.
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Open the Colors and Shelf Palettes
Basic painting on yourmodel involves selecting a brush, selecting a color, and using them to paint. In the steps
below, you'll select a color from theColors palette and a brush from your Shelf. To begin, let's open and arrange
those palettes.

TIP: By default, theColors and Shelf palettes are already open when you start Mari (but follow the
instructions below to see how to open and close palettes).

1. To open theColors palette:

• from theViewmenu, select Palettes > Colors, or

• right-click in the toolbar area and select Colors from the dropdownmenu.

TheColors palette displays.
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2. To open the Shelf palette:

• from theViewmenu, select Palettes > Shelf, or

• right-click in the toolbar area and select Shelf from the dropdownmenu.

The Shelf palette displays.

The shelf can hold your customized sets of colors and brushes - but when you first start Mari, the shelf is empty.

EXPERIMENT: TheMari Reference Guide outlines the different options for arranging palettes. Take a few
minutes to experiment with docking, undocking, sizing, moving, collapsing, and stacking palettes (including
theColors palette and Shelf). Over time, you'll find a configuration that works best for you. And when you
exit Mari, it remembers that configuration for the next time you re-start the program.
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Select a Color
1. You can select a color from theColors palette a few different ways:

• click in the color field

• click to select theH, S, orV next to the vertical sliders (to the right of the color field), then click and drag the
sliders up or down to select color and alpha

• enter an Intensity value or drag the slider to adjust the intensity of the color

• drag the horizontal sliders left or right, or type specific values in the boxes, to specify:

RGB( )or HSV( ),and Alpha( )

The selected color displays in the Foreground swatch (and in the swatch to the right of the vertical sliders).
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TIP: In addition to adjusting the intensity with the Intensity slider, you can also adjust it by selecting theV

component, to the right of the color swatch, and dragging the slider or dragging the RGB slider.

2. When the color you want is selected in theColors palette, drag the swatch to the Shelf.

You don't have to drag the color to the shelf to use it, but it's useful for storing colors you use regularly.

EXPERIMENT: Play around with all the different options for selecting colors. See if you can get these:

TIP: If you hover themouse over a swatch, it displays RGB, HSV, and Alpha values:

Select a Brush
1. To select a brush, open theBrush Editor palette:

• from theViewmenu, select Palettes > Brush Editor, or

• right-click in the toolbar area and select Brush Editor from the dropdownmenu.

TheBrush Editor palette displays.
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TheBrush Editor has three tabs:

• Properties - configurable properties of the selected brush (see theMari Reference Guide for details).

• Shelves - the same shelves that display in your Shelf palette.

• Presets - an array of predefined brushes that comewithMari.

2. Click the Presets tab.

Three tabs display along the top for different sets of predefined brushes.
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3. Click a brush to select it.

TIP: At the bottomof theBrush Editor is a scratch area for you to test out the selected brush. You can
pressN to swap back to the last brush tip you used. This lets you quickly swap back and forth between
two brush tips.

TIP: You can also customize brushes from theBrushEditor, and save them to the Shelf. This is covered in
theMari User Guide, but basically involves selecting a preset brush from the Presets tab, custom-
configuring that brush by selecting options on the Properties tab, or saving it by clicking the

button on the Shelves tab.

Paint!
1. When you have selected a color and a brush (from theColors palette, Brush Editor, and/or Shelf), you can use

them to paint on themodel. First select the paint tool:

• click on the toolbar, or

• press P.

2. Then paint!
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TIP: You can undo and redo any action by pressing Ctrl/Cmd+Z and Ctrl/Cmd+Y, or clicking and

on the Project toolbar, or selectingUndo and Redo from the Editmenu.
And, you can undo or redomultiple actions at once, by clicking on a specific action in theHistory View
palette (from theViewmenu, select Palettes > History View).

TheHistory View palette lists all actions you've performed since opening the project. There is no limit on
the size of the action history, but it clears when you close the project.

Redoing an action in Mari only reverses a previously undone action. You cannot use the Redo command in
Mari to repeat a command - it's reversing an Undo (not a “do that again”).

Bake Your Painting
1. As with other paint programs, what you paint stays in a paint buffer until you “bake” it onto themodel. To bake

in Mari, make sure all patches with unbaked painting are selected, and then:

• from the Paintingmenu, select Bake, or

• click on the status bar, or
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• pressB.

TIP: The Projection palette also includes aBake Behavior option, which by default
(AutoBakeAndClear) automatically bakes every time you adjust the view.

2. When you exit Mari, do not save the project. (We'll start the next lesson with the unpainted blacksmith you
imported in Tutorial 1.)

Where Do You Go from Here?
This lesson covered themost basic options for painting in Mari:

• selecting a color in various ways, and dragging it to the Shelf

• selecting a brush from theBrush Editor

• painting on themodel and baking.

The next tutorial, Tutorial 4: Painting Through and Clone Stamping, covers twomain options for using images to
create textures in Mari.
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Tutorial 4: Painting Through
and Clone Stamping

This lesson introduces using images to create textures in Mari. This includes “painting through” an image onto your
model and “clone stamping” part of an image onto yourmodel.

What You Should Know Before Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read theMari Getting Started Guide up to this point

• that you know how to start Mari (see Launching onWindows, Launching on Linux, or Launching onMac)

• that you have completed Tutorial 1: Setting up a Project, Tutorial 2: Setting the View, and Tutorial 3: Painting!

Resources You Need to Complete This Lesson

To complete this lesson, you need access to a computer that can runMari, and the following sample files:

• 1-Blacksmith - theMari project file you created in Tutorial 1 and used in Tutorial 2 and Tutorial 3

• Tattoo.png - an image of a tattoo, in yourMari tutorial directory

How Long Should It Take?

Plan on spending about 25 minutes to complete this lesson.

About Painting from Images in Mari
Likewith other paint programs, Mari lets you superimpose image files onto the surface of an object. To manage
image files, Mari includes the Image Manager palette. To paint with images you've loaded into the ImageManager
palette, Mari has twomain tools: Paint through and Clonestamp:

• The Paint through tool ( ) lets you position an image over an object, and then as you paint, copy from the
image directly onto what's under the brush.
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• TheClonestamp tool ( ) lets you position an image alongside an object, with a source point on the image
relative to where the brush is on the object. Then as you paint, the source point on the imagemoves in sync with
the brush on the object, andMari copies from the image onto the corresponding spot under the brush on the
object.

You can also clone stamp frompainting already on an object, in the paint buffer, or in another channel.

Steps for Painting Through and Clone Stamping

To paint through and clone stamp inMari, follow these steps:

1. Open Your Project

2. Load an Image

3. Paint Through

4. Clone Stamp

Open Your Project
1. Start Mari.

TheMari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open it.

Your project opens and switches to theOrtho view.
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Load an Image
For both painting through and clone stamping, we'll use an image of a tattoo that looks like this:

We'll start by loading that image in Mari's Image Manager palette.

1. To open the Image Manager:

• click the Image Manager tab if it is already open but hidden (as in the default Mari layout),

• from theViewmenu, select Palettes > Image Manager, or

• right-click in the toolbar area and select Image Manager from the dropdownmenu. The Image Manager
palette displays.
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2. To load an image, click .

TheOpen an Image dialog box displays.

3. Navigate to your tutorial folder, and select Tattoo.png.

The tattoo.png image displays in the Image Manager.
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Paint Through
Painting through an image basically involves:

• selecting the Paint Through tool,

• dragging an image onto the canvas, and

• painting.

1. Select the Paint Through tool by:

• clicking on the toolbar, or

• pressingU.

2. Drag the image from the Image Manager and drop it onto themodel.
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3. Move and resize the image:

• To resize the image, hold down Ctrl/Cmd+Shift, click and drag.

• To move the image around the canvas, hold down Shift, click and drag.

• To rotate the image, hold down Ctrl/Cmd, click and drag.

TIP: The ToolProperties palette includesmany options formanipulating paint-through images.

You can also double-click the image in the ImageManager, and crop a smaller portion to use for painting
through and clone stamping.
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EXPERIMENT: Try sizing, moving and rotating the image. See if you can get it to look like this:

4. Paint through the image onto themodel (hold down the left mouse button andmove, as you do in any standard
paint program).

5. When you're done painting through, press P to go to the Painting tool to see just the painted-on object.

TIP: To hide the overlying image, press the ? (questionmark) key. To paint thewhole image onto the
model in one step, press the ' (apostrophe) key. To repeat the source image (so you can paint past the
edges and have the source image repeat), press the ; (semicolon) key.

TUTORIAL 4: PAINTING THROUGH AND CLONE STAMPING | PAINT THROUGH



96

Clone Stamp
Clone stamping is like painting through, but the image does not have to sit directly on top of themodel.

1. First, clear the painted-through textures:

• from the Paintingmenu, select Clear Painting, or

• click on the toolbar.

This removes any unbaked painting on themodel. In this case, themodel re-displays as imported.

2. Select theClone Stamp tool: click on the toolbar.

3. Drag the image from the Image Manager and drop it onto the canvas.

The image displays in a separatewindow.

4. Re-size and position the imagewindow alongside yourmodel. To scale the imagewithin thewindow, hold down
Alt, right-click and drag. To pan the image, hold down Alt, left-click and drag.

5. To select the source point for cloning on the image, press Ctrl/Cmd and click.

Once you start painting, amagenta + displays the source point on the image.

6. Once you've selected the source, you can paint. The cursormoves on the image in sync with the cursor on the
model as it clone stamps from the image onto themodel.
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TIP: You can also clone stamp from existing textures - painted on the surface of the object, in the paint
buffer, or painted in another channel. To select a clone source, use the Sourcemenu in the Project
toolbar and select from the origins available.

EXPERIMENT: Change the view (as covered in Tutorial 2: Setting the View), and try both painting through
and clone stamping the image onto another side of the object. Do you like onemethod of using images to
paint more than the other?

Where Do You Go from Here?
This lesson covered the twomain options for painting images onto amodel:

• dragging an image and positioning it on top of an object, then Painting through the image onto the surface of the
object
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• dragging an image and positioning it on the canvas next to an object, then Clone stamping from a part of the
image to the surface of the object.

The next tutorial, Tutorial 5: Exporting and Importing, covers procedures for saving and re-importing your work.
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Tutorial 5: Exporting and
Importing

This lesson explains how you can export channels or layers you've painted in Mari as a set of image files, then re-
import them into your project. This familiarizes you with just a few of themethods for exporting and importing.

What You Should Know Before Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read theMari Getting Started Guide up to this point

• that you know how to start Mari (see Launching onWindows, Launching on Linux, or Launching onMac)

• that you have completed tutorials 1 through 4 - so you know the basics of creating aMari project, setting up the
camera and lighting, and painting textures.

Resources You Need to Complete This Lesson

To complete this lesson, you need access to a computer that can runMari, and the following sample files:

• 1-Blacksmith - theMari project file you created in tutorial 1 and used in tutorial 2, tutorial 3, and tutorial 4.

How Long Should It Take?

Plan on spending about 25 minutes to complete this lesson.

About Mari Exports
Mari includes the facility to export the painting in a project to a series of image files. Youmight use this, for example,
to modify part of your work in an external program, and then re-import thosemodifications into the project. Mari
lets you select formats and naming conventions for the export. Each export contains the painting baked in a selected
channel, one image file per patch. When you import a series of previously exported files, Mari lets you knowwhether
it's a complete set.
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Steps for Exporting and Importing

To export and import Mari painting, follow these steps:

1. Open Your Project

2. Export a Channel

3. Export a Layer

4. Import a Channel

5. Import a Layer

Open Your Project
1. Start Mari.

TheMari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open it.

Your project opens and switches to theOrtho view.
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Export a Channel
1. To export the current channel,Diffuse, from theChannelsmenu, select Export > Export Current Channel.

This exports the currently selected channel,Diffuse. To export any channel, right-click the channel you want to
export in theChannels palette, and select Export > Export Current Channel from the dropdownmenu.

The Export dialog box displays.

2. If necessary, use the two left-hand navigation boxes to navigate to the folder you want to export to.

3. In the Template field, Mari names each image file in the export, one per layer and per patch, based on this
template. The default is $CHANNEL.$LAYER.$UDIM.tif

NOTE: Notice the File Example below it, which displays what a filename looks likewith that template. In
the illustration, it's: diffuse.Base.1001.tif

So each filename includes the following (with examples from the illustration):
-$CHANNEL - the name of the channel you’re exporting layers from: Diffuse.
-$LAYER - the name of the layers you’re exporting: Base.
-$UDIM - an incremental number identifying each patch in those layers: 1001 (followed by 1002, 1003,
and so on).
-tif - the extension for the selected file format. You can set the format for the exported files by changing
this extension. Mari supports standard image formats (such as .png, .jpg, .tga, and .dds).

NOTE: Formore information on UDIM number, please refer to theWorking with Patches chapter in the
Mari User Guide.
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TIP: The formats available to export depend on the color depth of the channel. Channels with color set to
Half-Float or Float can only be exported to .psd, and .psb format. OnWindows, channels with color set to
Half-Float or Float also can be exported to .dds format.

4. Set theUse Template For field to determine if the template above is used forOnly this layer (to only use the
template for the layer displayed at the top of the dialog) or Everything (to apply the template to all layers in the
stack).

5. Click Export All Patches.

This exports all patches. Youmay be notified that the selected directory does not exist, and prompted about
whether you want to create the directory.

NOTE: If Small Textures is enabled, Mari exports any patches that you haven't painted yet, or have
painted as a single color, as 8x8-pixel textures. When you start to paint on a particular patch, Mari exports
it as the correct size.

TIP: For a complete explanation of export fields, see theMari Reference Guide and the Exporting and
Importing Textures chapter in theMari User Guide.

Export a Layer
1. To export selected layers, from the Layersmenu, select Export > Export Selected Layers.

This exports any selected layers in the layer stack (in this case, Base). The Export dialog box displays.

2. If necessary, use the two left-hand navigation boxes to navigate to your tutorial folder.
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3. In the Template field, Mari names each image file in the export, one per channel, layer and patch, based on this
template. The default is $CHANNEL.$LAYER.$UDIM.tif.

NOTE: Notice the File Example below it, which displays what a filename looks likewith that template. In
the illustration, it's: diffuse.Base.1001.tif

So each filename includes the following (with examples from the illustration):
-$CHANNEL - the name of the channel you’re exporting layers from: Diffuse.
-$LAYER - the name of the layers you’re exporting: Base.
-$UDIM - an incremental number identifying each patch in those layers: 1001 (followed by 1002, 1003,
and so on).
-tif - the extension for the selected file format. You can set the format for the exported files by changing
this extension. Mari supports standard image formats (such as .png, .jpg, .tga, and .dds).

TIP: The formats available to export depend on the color depth of the channel. Channels with color set to
Half-Float or Float can only be exported to .psd, and .psb format. OnWindows, channels with color set to
Half-Float or Float also can be exported to .dds format.

4. Set theUse Template For field to determine if the template above is used forOnly this layer or Everything.
If Only this layer is selected when attempting to export, Mari asks you for each individual layer whether you
want to use the template. Setting the files to Everything can save time if you want all your selected layers to
use the template.

5. Click Export All Patches.

This exports all patches.

NOTE: If Small Textures is enabled, Mari exports any patches that you haven't painted yet, or have
painted as a single color, as 8x8-pixel textures. When you start to paint on a particular patch, Mari exports
it as the correct size.

TIP: For a complete explanation of export fields, see theMari Reference Guide and the Exporting and
Importing Textures chapter in theMari User Guide.

Import a Channel
1. To import a channel (for example if you've tweaked some exported image files in another application and now

want themback in your texture):

• from theChannelsmenu, select Import > Import into Layer Stack for the currently selected channel, or

• right-click on the channel where you want to import the textures (in this case, Color) in theChannels palette,
and select Import > Import into Layer Stack from the dropdownmenu.

The Import dialog box displays.
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2. Select the path for the imported images, by either:

• typing it in the Path field at the top of the dialog,

• clicking on it in your directory bookmarks (to the left), or

• browsing to it in themiddle panes.

If you are using themiddle panes to browse to the directory, you can use the buttons above the view to navigate
back, forward, up one directory level, create a new directory, or switch between icon-only and full-details
directory views.

3. Select the texture set to import.

Mari shows all the texture sets available under the selected directory, arranged by sub-directory.

For each texture set, the Import dialog box includes:

• Full - shows a green bar if the selected image sequence has a full set of images for the current model, a yellow
bar if the selected image sequence has a partial set of images for the current model, or a red bar if the selected
image sequence has no images for the current model.

• Images - the name of each image to import, with theUDIM number represented as@ (in this case,
diffuse.@.tif) and frame number (if present) represented as #.

• Start and End - the first and last UDIM numbers in the image set (in this case, 1001 to 1055).

• Patch Count - the number of images in the set (in this case, 50).

4. In the Template field, Mari names each image file in the import, one per layer and patch, based on this
template. The default is $CHANNEL.$LAYER.$UDIM.tif.
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NOTE: Notice the File Example below the Template field, which displays what a filename looks likewith
that template. In the illustration, it's: diffuse.Base.@.tif

So each filename includes the following (with examples from the illustration):
-$CHANNEL - the name of the channel you’re importing: Diffuse.
-$LAYER - the name of the layers you’re importing: Base.
-$UDIM - an incremental number identifying each patch in those layers: 1001 (followed by 1002, 1003,
and so on).
-tif - the extension for the selected file format. You can set the format for the exported files by changing
this extension. Mari supports standard image formats (such as .tif, .exr, .png, .jpg, .tga, and .dds).

5. Click the Import All Patches to import the files into your project.

Mari imports the textures from the selected files.

Import a Layer
1. To import textures into a layer, from the Layersmenu, select Import > Import into Layer.

This imports all selected textures into the current, selected layer (in this case, Base). The Import dialog box
displays.

2. Select the path for the imported images, by either:

• typing it in the Path field at the top of the dialog,

• clicking on it in your directory bookmarks (to the left), or

• browsing to it in themiddle panes.

If you are using themiddle panes to browse to the directory, you can use the buttons above the view to navigate
back, forward, up one directory level, create a new directory, or switch between icon-only and full-details
directory views.
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3. Select the texture set to import.

Mari shows all the texture sets available under the selected directory, arranged by sub-directory.

For each texture set, the Import dialog box includes:

• Full - shows a green bar if the selected image sequence has a full set of images for the current model, a yellow
bar if the selected image sequence has a partial set of images for the current model, or a red bar if the selected
image sequence has no images for the current model.

• Images - the name of each image to import, with theUDIM number represented as@ (in this case,
diffuse.@.tif) and frame number (if present) represented as #.

• Start and End - the first and last UDIM numbers in the image set (in this case, 1001 to 1055).

• Patch Count - the number of images in the set (in this case, 50).

4. In the Template field, Mari names each image file in the import, one per channel, layer and patch, based on this
template. The default is $CHANNEL.$LAYER.$UDIM.tif.

NOTE: Notice the FileExample below the Template field, which displays what a filename looks likewith
that template. In the illustration, it's: diffuse.Base.@.tif

So each filename includes the following (with examples from the illustration):
-$CHANNEL - the name of the channel you’re importing: Diffuse.
-$LAYER - the name of the layers you’re importing: Base.
-$UDIM - an incremental number identifying each patch in those layers: 1001 (followed by 1002, 1003,
and so on).
-tif - the extension for the selected file format. You can set the format for the exported files by changing
this extension. Mari supports standard image formats (such as .tif, .exr, .png, .jpg, .tga, and .dds).

5. Click Import All Patches.

This imports all patches.

TIP: For a complete explanation of export fields, see theMari Reference Guide and Exporting and
Importing Textures chapter inMari User Guide.

Where Do You Go from Here?
This lesson showed you how to:

• export a current channel or selected layer in aMari project to a series of image files.

• import textures into a channel’s layer stack or into a selected layer, for example after havingmanipulated the
exported textures in another program.

Congratulations! You have now completed all modules in theMari Tutorials. To better familiarize yourself with the
features you are particularly interested in or to get answers to specific problems that arise during painting, please
refer to the accompanyingMari User Guide andMari Reference Guide.
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